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FileMaker Pro is a relational database package for the Macintosh and the PC. It ha
user-friendly interface and is a popular database program, especially with novice
database users. FileMaker Pro is used by many of the departments at HMC. For ex
the Humanities and Social Sciences Department uses a FileMaker Pro database to
manage their advising records during the advising period. Many of the department
secretaries use the Harvey Mudd Accounting Database (HMAD) developed by Acad
Computing to track vendor information, account number and budget information,
departmental expenditures, and inventory.

NEW FEATURES
A new version of FileMaker Pro was recently released for both the Macintosh and th
PC. FileMaker Pro 4.0 has many new features including expanded Sort and Find op
new calculation functions, and the ability to import Excel spreadsheets directly into 
database file. The most interesting new features relate to its new Internet and Web
publishing support, however. New Internet features include GIF and JPEG support,
export of database data to HTML tables, and email and URL support. Web publishin
support consists of FileMaker Pro’s ability to directly serve FileMaker Pro files to the
Web using a built-in feature called the Web Companion.

THE WEB COMPANION
Previously, you needed a separate Web server and additional software (such as La
serve FileMaker Pro files over the Web. With the new version of FileMaker Pro, the
FileMaker Pro application itself acts as the Web server. FileMaker Pro incorporates
built-in plug-in called the Web Companion which does the work of serving your data
file over the Web. By first enabling the Web Companion plug-in and then configuring
you can publish your file over the Web using one of two options available: Instant W
Publishing and Custom Web Publishing.

INSTANT WEB PUBLISHING
With Instant Web Publishing you simply open your database file and enable Web
Companion Sharing in the File Sharing dialog box. You can then launch a Web brow
such as Netscape Navigator or Internet Explorer and go to the IP address of the ma
that the database is running on. FileMaker Pro provides a default home page with a
to all of the databases that you are sharing via the Web Companion.

FileMaker Pro provides a Web interface to your database that allows users to view
records in the database both as a single-record form and as a multi-record table. U
can browse, search, sort, edit, delete and add new records depending on what acc
privileges you have provided. Access privileges can be set by using FileMaker Pro’s
built-in password protection features. You can also specify which fields of your data
will be published on the Web by designing layouts in FileMaker (continued on page 5)
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Controlling Access to
Your Web Pages
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There are many occasions where you ma
want to restrict access to the Web pages
that you create. For example certain
information might be appropriate only for
the HMC community; a faculty member
might want to disseminate information
only to the students in his/her class; or yo
might want to give sensitive information t
only a specific person.

In general there are two ways to limit
access to Web pages. In the first method
access is controlled through the use of a
password that the user must enter before
they can see the page. In the second
method pages or whole directories can
only be accessed from certain connectio
locations, i.e. from  machines with an IP
address in a certain domain or even from
single machine only.

Access control is implemented in differen
ways depending on the Web server
software running on the server. In some
cases the author of the Web pages can h
personal control over access to his/her
pages; in other cases the webmaster mu
configure the server. In this article we wil
discuss the options for access control on
some of the Web servers at HMC.

ACCESS CONTROL ON ORION
Orion’s Web server is used primarily by
students for their home pages. Students 
create Web pages by running the comma
make_www in their home directory. This
command creates a subdirectory called
www-home in the users’s home directory.
The subdirectory has the appropriate file
permissions for the Web server to be abl
to access files in the directory. Files in th
y
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subdirectory are thus accessible over the
Web at the URL http://www3.hmc.edu/
~username/.

Orion’s Web server is running Apache
server software. This software supports
user-configurable access control. Studen
can control access to their Web pages bo
by connection location and by password.

Connection location access control is
provided by creating a special file called 
.htaccess file. The file is placed in the
directory you want to protect and protects
all subdirectories in that directory as well
Commands in the file specify the domain
or IP addresses that can have access to
your pages.

Password protection is accomplished by
creating a password file using the
htpasswd command. Details on both of
these methods can be found in Orion’s
Web documentation library at http://

www3.hmc.edu/docs/www/.

ACCESS CONTROL ON THUBAN
Thuban’s Web server runs OSU Web
server software and is used by a variety o
groups including faculty, staff, and colleg
organizations. Faculty and staff can use
their home directories to create home
pages in much the same way that studen
can use their home directories on Orion.
Running the command
@AC_COM:MAKE_WWW creates a directory
called www-home where users can store
files they want to make accessible over th
Web. The Web pages can be accessed a
the URL http://www2.hmc.edu/
~username/.



The semester is drawing to a
close and our thoughts begin to turn to
summer projects. Just in case you
needed some new ideas we thought
we’d describe some new tools that are
available, as well as some tools that
have been around for a while, but that
might not be so familiar.

The first tool is the new version of
FileMaker Pro, a database package for
the Macintosh and PC. This version has
several new features, including the
ability to serve database files directly
over the Web. Another Web-related tool
is the ability to control access to Web
pages. We describe how to add location-
based or password-based access control
to your Web pages on the main Web
servers maintained by Academic
Computing.

Adobe Acrobat and the PDF file format
are another tool you might want to
explore further. In addition to being used
as a way to distribute documents that
contain scientific and mathematical
notation over the Web, PDF is also
being used by many organizations to
distribute documentation via other
media, for example on CD-ROM or by
email.

Finally, if you are a Eudora user be sure
to check out this month’s Tricks&Tips.
We guarantee you will find it useful.

—Elizabeth Hodas
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E ditor’s Notes

Users cannot currently control access to
their Web pages themselves. Changes m
be made by the webmaster for Thuban’s
Web server, Roger Wiechman. Users wh
are interested in changing access to thei
Web pages on Thuban should contact
Roger at Roger_Wiechman@hmc.edu.

ACCESS CONTROL ON WWW4.HMC.EDU
WWW4.HMC.EDU is the HMC
Courseware Server. It is a WebStar serve
which runs on a Macintosh computer. Th
server is used primarily by faculty to crea
Web pages for their courses and support
several specialized programs for forms,
dynamic Web pages, and conferencing,
among others.

There are actually two separate coursew
servers running on different ports on the
server. The first, www4.hmc.edu, is
restricted to access by computers at the
Claremont Colleges only. The second,
www4.hmc.edu:8000, permits worldwide
access. By choosing which server to use
faculty members can easily restrict acces
to their pages to members of the Clarem
Colleges only. Details on using the
Courseware Servers can be found at the
home pages at http://www4.hmc.edu/
and http://www4.hmc.edu:8000/.

Users can also create password-protecte
pages by using one of the programs on t
server called NetCloak. NetCloak uses
special commands which are added to y
Web pages that can require users to ente
password before they can see your page
For more information on using NetCloak
check the documentation available on th
Courseware Server home page at http://
www4.hmc.edu/ and in the NetCloak
User’s Guide at http://www4.hmc.edu/
NCUsersGuide/contents.html. z
Occasional Downtime is published bimonthly

by the Academic Computing Department at
Harvey Mudd College. It is also available in a

variety of formats on the HMC Web Server.

Comments and questions can be directed to
downtime@hmc.edu. 3
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File Types
& Formats
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Most of the time you don’t need to worry
about a file’s type when you’re working
with computers. But every once in a while
you’ll find yourself in a situation where it’s
useful to understand a little about file typ

and how they work.

But first, what do we
mean when we talk
about file types? In

simple terms: Files
typically store data; differen

applications use different file
formats to represent the data. The file
type indicates how the data is
formatted. For example, a word

processing application such as
Microsoft Word will use certain
codes to represent a table or bold

text. Another word processing
program such as WordPerfect might use
different codes to represent the same
elements. In order for an application to
open a file in a particular file format it
must either understand and be able to
interpret the codes in the file or have
translators which allow it to translate the
other format into something it understand

In the PC, Unix, and VMS world, file type
are usually indicated by the extension us
in the filename. For example, the extensi
.txt indicates a text file, .ps indicates a
postscript file, and .wav indicates a WAV
sound file. On the Macintosh, the file type
is determined by a pair of hidden 4-letter
codes maintained by the system. These
codes also determine the file’s icon, whic
is the visual indicator of its type.

On the Mac and the PC you can usually
just double-click on a file’s icon to open it
s

s.

d
n

in the appropriate
application. If you don’t
have the application that
was used to create the
document this will
probably not work.
Documents received
as email attachments
often generate a call to the Help Desk due
to this file type problem. The document
was created in an application that the use
doesn’t have so when he/she tries to open
it they get an error message. The answer 
this problem is to first launch an
application that might have translators tha
will allow it to convert the file.  Then open
the file from within the application (i.e.
select Open from the File menu).
Microsoft Word, for example, has many
translators which allow it to open files
created in other word processors or in
previous versions of Word.

This will only work if the application has
the appropriate translators, of course. Not
all applications can open all file types, nor
would you expect them to. For example,
the application GraphicConverter for the
Macintosh can open many different
graphics file types, but you wouldn’t
expect it to be able to open a sound file or
word processing file.

Another common situation where it’s
useful to know a little about file types is
when you’re surfing the Web. There are
many different file types in use on the Web
and in order for your Web browser to
display them it needs to be configured to
use the appropriate helper application or
plug-in. For example if you want to be able
to display and read a PDF file you’ll need
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FileMaker Pro continued from page 1

Pro that include only the fields you want
visible. If you have a relational database
and want to use related fields on the Web
you can add those related fields to your
layout as well.

CUSTOM WEB PUBLISHING
Instant Web Publishing is a great way for
the novice user to get their database on 
Web. It requires no knowledge of HTML
yet still provides users with full access to
your database. The disadvantage is that
you are limited to the interface provided 
FileMaker Pro. If you want to customize
your database on the Web in any way at 
you must use the Custom Web Publishin
feature.

Custom Web Publishing is a much more
powerful way to publish your database o
the Web. By using a combination of
regular HTML tags and special CDML
(Claris Dynamic Markup Language) tags
you create format files which customize
the appearance of your FileMaker Pro da
on the Web. The CDML tags enable the
HTML pages to interact with FileMaker
Pro. Online documentation and several
example databases are provided with
FileMaker Pro. Unfortunately, the learnin
curve for learning to use the CDML tags 
fairly high. If you are a novice FileMaker
Pro user and not familiar with HTML then
Instant Web Publishing would probably b
a better choice.

AC FILEMAKER PRO WEB SERVER
Academic Computing currently has a tes
FileMaker Pro Web server running on a
Power Macintosh 6100/66. If you are
interested in experimenting with making 
FileMaker Pro database accessible over
Web please contact
Elizabeth_Hodas@hmc.edu. If there is
demand for a college FileMaker Pro Web
server, Academic Computing will conside
making it more accessible (similar to the
Macintosh WebStar Courseware Server,
www4.hmc.edu). z

d

COMMON FILE FORMATS

ENCODING FORMATS

.uu uuencoded file

.hqx BinHex file

COMPRESSION FORMATS

.zip Zip compressed file

.gz GZIP compressed file

.sit StuffIt file

.sea Self-extracting archive

.Z Unix Compress file

.tar Unix tape archive file

GRAPHICS FILE TYPES

.pict PICT file

.tiff TIFF file

.gif GIF file

.jpg JPEG file

AUDIO FILE TYPES

.wav WAV file

.au Ulaw file

.midi MIDI file

.ra RealAudio file

.aiff AIFF file

VIDEO FILE TYPES

.mpeg MPEG file

.mov QuickTime video file

.avi AVI file

OTHER FILE TYPES

.txt Text file

.html HTML file

.rtf RTF (Rich Text Format) file

.pdf PDF file

.ps Postscript file

.eps Encapsulated postscript file

.exe PC executable file

.doc Word processing document

.ppt Powerpoint document

.xls Excel document

.fp3 FileMaker Pro document

.dcr MacroMedia Shockwave file

the Acrobat Reader or Acrobat plug-in
from Adobe. To view a MacroMedia
Director file on the Web you’ll need the
Shockwave plug-in. The list can go on an
on. z
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Adobe Acrobat
Part I: The PDF format™
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PDF stands for Portable Document Form
and was developed by Adobe Systems i
the early 1990’s as a way to address som
of the problems inherent in publishing an
distributing documents electronically. On
of the main problems with distributing
documents electronically among a group
people is that not everyone in the group
will have the exact same computer setup
even at a small business or organization
For example, at Harvey Mudd College a
user’s computer system might consist of
dumb terminal, a Macintosh, a PC runnin
Windows 95 or Windows NT, a UNIX
workstation or some other type of
workstation. Even among users with the
same computer platform it is possible to
have a wide variety of installed software
and fonts.

This makes it very difficult to distribute a
electronic document such as a word
processing file to a large group of people
One solution is to only distribute plain-te
documents, which can easily be sent by
email. This is not optimal, however, since
it eliminates all of the formatting, fonts,
color, and graphics that make a docume
compelling and readable.

PDF was developed to address some of
these problems. Adobe Acrobat, a softwa
package developed by Adobe Systems,
converts a document which was created
another program (such as Microsoft Wor
or Adobe Pagemaker) into a PDF
document. The advantage of the PDF
document is that it retains all of the fonts
formatting, layout and graphics of the
original document. Users need only obta
the free Acrobat Reader program from
Adobe to open the PDF document on the
computer. Acrobat Reader is available fo
at
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most operating systems including
Macintosh, Windows 95, Windows NT,
Windows 3.1, LINUX, Solaris, and
SunOS. (It is unfortunately not available
for VMS). A PDF document can be sent b
email, put on a Web site, or distributed on
a floppy or CD-ROM.

THE ACROBAT READER
Reading an electronic document online is
not always comfortable or easy. Small fon
sizes and the need to scroll around in a
long document can be hard on the eyes a
the wrist. Acrobat Reader, the program th
you use to open and read a PDF docume
has many features which make reading a
electronic document more comfortable.

Bookmarks and page thumbnails make
finding what you want easy in even a lon
document. Navigation buttons let you
quickly go from page to page or jump to
the beginning or end of the document.

Multiple zoom buttons allow you to
quickly magnify the page to make reading
small fonts easier. Acrobat Reader even
supports the concept of articles within a
document which make it easy to navigate
through the columns of an article even
when it is split up on different pages of th
document.

PDF documents can even have hypertex
links which when you click on them can
take you to another section in the same
PDF file, to another PDF document, or to
URL on the World Wide Web.

Adobe has also developed an Acrobat
plug-in which when used with a browser
such as Netscape Navigator, allows you 
view a PDF document within a browser
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SELECTING MESSAGES IN EUDORA
Each row in a Eudora mailbox represents a
message and is referred to as a message
summary. There are several useful tricks to
selecting one or more message summaries
in a mailbox.

▼ Single-click on a message summary to
select it.

▼ Single-click on a message summary and
then hold down the Shift key and click
on another summary to select both
summaries and all of the summaries
between them.

▼ To select “disjointed” message
summaries (i.e. message summaries that
are not one after another) hold down the
Command key on the Macintosh or the
Ctrl key on the PC while you select the
summaries.

▼ To quickly select all of the messages
from a particular person, hold down the
Option key on the Macintosh or the Alt
key on a PC and click on the sender’s
name in a message summary (i.e. click
in the Who field of the message
summary). The message summaries will
be grouped together and selected.

▼ To quickly select all of the messages on
a particular subject (including replies to
a message) hold down the Option key
on the Macintosh or the Alt key on a PC
and click on the Subject field of a
message. The messages will be grouped
together and selected. This is a great
way to quickly group together all of the
messages that were sent back and forth
on a particular topic and transfer them
all at once to another mailbox.

Try these tricks out next time you need to
sort through your Inbox and you will be
amazed how much more quickly you can
reduce the number of messages in your
Inbox! z
window. Acrobat Reader is distributed for
free by Adobe Systems and is available f
downloading from Adobe’s Web site at
http://www.adobe.com/. It has been
installed on all of the lab machines in the
Academic Computing computer labs.

WHO USES PDF?
With the explosion in popularity of the
World Wide Web PDF has become a very
popular way to distribute documents
electronically. HTML is of course the mos
common way to make information
available on the Web, but as a publishing
medium it is severely limiting. Some
advances have been made with extensio
to HTML, but for many kinds of
information it is simply not very suitable.
It can also require a great deal of time an
effort to convert already existing
documentation into HTML. Many
companies are therefore using Acrobat to
distribute documentation on the Web. The
IRS, for example, makes all of its tax
forms available on the Web in PDF forma
Researchers wanting to submit grant
proposals to the National Science
Foundation can submit them in PDF
format over the Web. Even Occasional
Downtime is distributed in PDF format on
the Web.

Another problem with HTML is that while
work is being done to extend its
capabilities, it does not provide much
support for text that includes mathematic
and/or scientific notation. The only way to
present formulas created in Microsoft
Word’s Equation Editor or in LaTEX for
example, was to convert them into GIFs
and incorporate them into the HTML as in
line images. Microsoft Word and LaTEX
documents can now easily be converted
into PDF documents. At Harvey Mudd
College several professors have begun
distributing homework problems and
solutions, class notes and other materials
PDF format on the Web. z

Next issue: How to create a PDF docume
7
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Q: Someone sent me a Microsoft Word 9
document, but I only use Word 6.0 on
my Macintosh. How can I open this
file?

A: Microsoft recently released a convert
which will allow users of Word 5.x and
6.x for the Macintosh to open
documents created in Word 97 for
Windows. This converter will also
convert documents created in the new
version of Word 98 for Macintosh. The
converter can be downloaded from
Microsoft’s Web site at http://
www.microsoft.com/macoffice/

prodinfo/office/coexist.htm.

Q: I have a FileMaker Pro file that I’m
designing. I would like to have a data
entry aid on one of the fields that has
pop-up list of values for the field. I’ve
looked everywhere in the Define Field
dialog box but can’t find a place to
define this data entry aid. How do I do
it?

A: This type of data entry aid is not
defined in the Define Fields/Entry
Options dialog box, even though you
can define several other data entry ai
there. Pop-up lists like you describe a
defined as part of your layout design.

First switch to Layout mode and selec
the field you want to create a pop-up
list for. Then choose Field Format from
the Format menu. In the dialog box
select “Pop-up list using value list” for
Style and then choose Define Value
Lists. In the Define Value Lists dialog
box type a name for the value list and
then click Create. Then type the value
you want to appear in the pop-up list.
7
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You can reuse value lists for other
fields. Value lists can save you a lot of
time and help make your data more
accurate and consistent.

Q: I have a chart in Excel and I want to
replace the standard data markers wit
something different. Can I do this, and
if so, how?

A: Excel provides several standard data
markers consisting of various squares
circles, diamonds and triangles, but it’s
actually pretty easy to change them to
something different.

First create your chart as you normally
would (this trick works best with line
charts). Copy the picture you want to
use in place of the standard data
marker to the Clipboard. (In most
programs just select the picture by
clicking on it, then choose Copy from
the Edit menu.) Display the chart you
are working on and select the data
series whose data markers you want t
replace by clicking on the series. Then
choose Paste from the Edit menu.   z
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